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What is the National Transit Database?  

The NTD was established by Congress to be the Nation’s primary source for information and statistics on the transit systems  
of the United States. Recipients or beneficiaries of grants from the Federal Transit Administration (FTA) under the Urbanized  
Area Formula Program (§5307) or Other than Urbanized Area (Rural) Formula Program (§5311) are required by statute to  
submit data to the NTD. Over 660 transit providers in urbanized areas currently report to the NTD through the Internet-based  
reporting system. Each year, NTD performance data are used to apportion over $5 billion of FTA funds to transit agencies in  
urbanized areas (UZAs). Annual NTD reports are submitted to Congress summarizing transit service and safety data.  

The legislative requirement for the NTD is found in Title 49 U.S.C. 5335(a):  

SECTION 5335 National transit database  

(a) NATIONAL TRANSIT DATABASE — To help meet the needs of individual public transportation systems, the United  
States Government, State and local governments, and the public for information on which to base public transportation  
service planning, the Secretary of Transportation shall maintain a reporting system, using uniform categories to  
accumulate public transportation financial and operating information and using a uniform system of accounts. The  
reporting and uniform systems shall contain appropriate information to help any level of government make a public  
sector investment decision. The Secretary may request and receive appropriate information from any source.  

(b) REPORTING AND UNIFORM SYSTEMS — the Secretary may award a grant under Section 5307 or 5311 only if the  
applicant and any person that will receive benefits directly from the grant, are subject to the reporting and uniform  
systems.  

The NTD reporting system evolved from the transit industry-initiated Project FARE (Uniform Financial Accounting and  
Reporting Elements). Both the private and public sectors have recognized the importance of timely and accurate data in 
assessing the continued progress of the nation's public transportation systems.  

Funding for Transit Agencies Serving Urbanized Areas under 200,000 Population  
NTD data are used in the formula allocation of Federal transit funds for the Urbanized Area Formula Program (§5307) and  
for the Fixed Guideway Modernization Program (§5309, in part). The NTD data are also used in the formula allocations of  
Federal transit funds. Prior to the Safe, Accountable, Flexible, and Efficient Transportation Equity Act: A Legacy for Users  
(SAFETEA-LU), only NTD data for urbanized areas with populations of 200,000 or more were used. With the passage of  
SAFETEA-LU, NTD data for urbanized areas with populations fewer than 200,000 are also used in the allocation of Federal  
transit funding.  

SAFETEA-LU provides for one-percent of the funds in the Section 5307 to be allocated according to the Small Transit  
Intensive Cities (STIC) formula. Under the formula for STIC, funds are apportioned to UZAs with populations less than 
200,000 that meet or exceed the average level of service for all UZAs with populations between 200,000 and 1,000,000. 
Three of the average level of service measurements in the formula allocation rely on passenger mile data. Because transit 
agencies in these smaller UZAs also depend on the data reported to the NTD for formula funding, following the 2008  
mandatory sampling year for all transit agencies, those transit agencies not required to sample annually will be required to 
sample every three years. There will no longer be a five-year cycle.  

SAFETEA-LU also establishes new Growing States and High Density States formula factors (§5340) to distribute funds to  
the §5307 and §5311 programs. One-half of the funds are made available under the Growing States factors and are  
apportioned by a formula based on state population forecasts for 15 years beyond the most recent Census. Amounts  
apportioned for each state are then distributed between UZAs and nonurbanzied (non-UZAs) areas based on the ratio of  
UZA / non-UZA population within each State. The High Density States factors distribute the other half of the funds to states  
with population densities in excess of 370 persons per square mile. These funds are apportioned only to UZAs within those  
states.  

For more information on SAFETEA-LU, contact your regional administrator or go to www.fta.dot.gov.  

Reporting Manuals and Modules  
To facilitate reporting to the NTD, the National Transit Database (NTD) Reporting Manual is divided into four reporting 
modules, each comprised of a series of data modules, as described below:  

1.   NTD Annual Reporting Manual  
•    Basic Information Module  
•    Financial Module  
•    Asset Module  
•    Service Module  
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•    Resource Module  
•    Federal Funding Allocation Statistics Module  
•    Declarations  

2.   NTD Monthly Reporting Manual  
•    Monthly Module  

3.   NTD Safety and Security Reporting Manual  
•    Safety and Security Module  
•    Chief Executive Officer Certification  

4.   NTD Rural Reporting Manual (exclusively rural reporters)  
•    Rural Module.  

Changes in 2009 Monthly Reporting  

In its ongoing efforts to improve upon the NTD Internet Reporting system and to be responsive to the needs of the transit  
agencies reporting to NTD and the transit community, FTA continues to refine and clarify reporting requirements and Internet 
Reporting.  

Reporting changes for the 2009 NTD are highlighted below. Specific changes are discussed in detail in the applicable 
sections of this manual.  

The following exhibit describes changes by reporting form.  
 

Exhibit 1 — CY 2009 Reporting Changes and Highlights  

1.  Agencies are required to report only the number of typical days operated in the month. However, unlinked passenger trips,  
vehicle revenue miles, vehicle revenue hours and vehicles operated in maximum service must be reported for all days in the 
month, including non-typical days such as weekends.  

2.  Beginnings with the 2009 calendar year, validation checks have been incorporated and are available from the Issues tab.  
3. A report comparing Monthly data with the most recent submitted Annual data is available from the Reports tab.  
4. Agencies are encouraged to make changes to the data for any month(s) in the current calendar year, as necessary, to  
 ensure that the best available data is reported. Changes can be made without requesting permission from FTA. A change to  
 a prior year’s data requires authorization from FTA.  
5.  FTA publishes a monthly data dump of all data reported in the Monthly module. This data dump can be found in the NTD  

website (www.ntdprogram.gov/ntdprogram/data.htm) under the heading: Monthly Database (Monthly Module Data Release 
and Monthly Module Adjusted Data Release). The files are updated on or about the 7th of each month.  

 
Who, What, How, When and Where to Report  
 
Who Reports  
Transit providers, States, or Metropolitan Planning Organizations (MPOs) that receive Urbanized Area Formula Program  
(§5307) grants, or that directly benefit from these grants, must report to the NTD or coordinate the submittal of data to the  
NTD on their behalf. The requirement to report begins in the year after you apply for a §5307 Grant, or in the year in which  
benefits are first received from a §5307 grant, whichever is sooner. The reporting requirement lasts for as long as the §5307  
remains open, or through the minimum useful life of any capital assets purchased with §5307 grant funds, whichever is later.  

Please note that this means that you may be required to report in year in which no §5307 grant funds were received. An NTD 
reporter that is no longer required to report to the NTD, should continue to file NTD reports if that reporter intends to apply for a 
§5307 or a §5311 grant in the future.  

Recipients or direct beneficiaries from Other than Urbanized Area Program (§5311) grants are also required to report to the 
NTD, under the streamlined Rural NTD reporting requirements. Please consult the Rural NTD Reporting Manual for more 
information on these requirements.  

A complete understanding of who must submit an NTD report requires an understanding of the following:  

•    Purchased transportation services  
•    Consolidated NTD reporters  
•    Voluntary reporters  
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•    Nine or fewer vehicles waiver.  

 

Example 1 — Continuing Requirements  

A transit agency purchases a vehicle with Urbanized Area Formula Program (UAF) funds. 
The vehicle, a 40-foot bus (MB), has a useful life of 12 years or 500,000 miles.  
The transit agency must report under the NTD program throughout the useful life of the vehicle regardless of whether or not the 
transit agency receives Urbanized Area Formula Program (UAF) funds during a particular year.  

 
Purchased Transportation Services  

The NTD operates under a “you buy it, you report it” rule. Thus, sellers of purchased transportation (PT) services are 
generally not required to report to the NTD - data for the service are generally reported by the agency purchasing the 
service (buyer).  

The NTD generally does not recognize agreements or memorandums of understanding between two public agencies as 
“purchased transportation services.” In these cases, the two public agencies should agree which of them will report the 
service to the NTD, and report the service as directly operated (DO).  
 
Consolidated NTD Reporters  

Consolidated NTD reporters are a collection of transit agencies filing one report. One reporter may file a consolidated report on 
behalf of other reporters if it is easier to collect and control the quality of the data. This often occurs when one transit agency 
coordinates the development and funding of public transportation services in an area. Transit agencies filing a  
consolidated report must operate within the same UZA.  
 
Voluntary Reporters  

FTA encourages all providers of transit service in urbanized areas to report to the NTD, regardless of whether they are public  
or private, and regardless of whether or not they receive or benefit from §5307 grants. To be accepted as a voluntary  
reporter in the NTD, you must be a provider of transit services in at least one urbanized area (UZA), and be able to comply  
with all of the NTD reporting requirements and the Uniform System of Accounts (USOA.) All urbanized area NTD reporters  
are required to comply with all NTD requirements for the Annual, Monthly, and Safety & Security Modules. Please refer to  
the Monthly Reporting Manual and the Safety & Security Reporting Manual for information on the reporting requirements of  
those modules.  
 
Nine or Fewer Vehicles Waiver  

Transit agencies with nine or fewer vehicles in annual maximum service (VOMS) that operate only non-fixed guideway 
(NFG) systems are not required to file a NTD Monthly report. The system will not generate forms for agencies with an 
approved 9 or fewer vehicles waiver.  

What to Report  
The NTD Monthly report consists of a series of forms that collect data providing FTA with monthly trends in ridership and  
service supplied throughout the year. It must contain all the public transportation service, including complementary  
paratransit services required by the Americans with Disabilities Act of 1990 (ADA), which the transit agency provides or  
purchases.  

For purchased transportation (PT) service, the report must contain data only for those services under contract.  
 
Reporting Modules and Forms  

All agencies are required to submit data on a monthly basis. The following exhibit presents a summary of NTD Monthly 
reporting requirements.  

 
Exhibit 2 — Summary of NTD Reporting Requirements  

NTD Monthly Report  
Mode Service Operated form (MR-10) All reporters 
Ridership Activity form (MR-20) All reporters 
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Calendar Year Data  

Unlike the NTD Annual report, which covers the 12-month fiscal year period, the data in the NTD Monthly report covers a 12- 
month period corresponding to the calendar year.  

How to Report  
This section describes the following:  

•    NTD identification number (NTD ID)  
•    Internet reporting  
•    Reporting format  
•    Purchased transportation (PT).  
 
The NTD Identification Number  

Each reporter is assigned a unique four-digit NTD, which is to be used in all NTD reports and correspondence. The first digit of 
the NTD ID corresponds to the FTA Region where the reporter is located (e.g., 9### indicates Region IX).  
 
Internet Reporting  

All required forms are completed using Internet Reporting which is accessible from the NTD website at  
www.ntdprogram.gov. Completing the Mode Service Operated form (MR-10) automatically generates the required Ridership 
Activity forms (MR-20) for the transit agency.  

This manual contains all information necessary to complete the NTD Monthly report using Internet Reporting. See the  
Internet Reporting section of this manual for specifics. FTA provides Internet Reporting user names and passwords to transit 
agencies.  
 
Reporting Format  

Transit agencies must submit their reports via the Internet Reporting system. A transit agency must file a complete report by 
the report due date. See the When to Report section below to determine your due date.  

General Formatting Rules  

Data reported must adhere to the following rules:  

• Follow rounding directions for each form 
• Unless otherwise indicated, report data as whole numbers 
• Use four digits for year entries. 

Internet Reporting incorporates these rules, formatting data automatically when you complete a cell entry.  
 
Reporting Purchased Transportation  

Purchased transportation (PT) service is service provided to a public transit agency or governmental unit from a public or  
private transportation provider based on a written contract. A contractual relationship exists only if all the following criteria are  
met:  

•    The seller is obligated in advance of the time the service is furnished to provide the operations for which the operating  
 statistics are being reported for a specific monetary consideration.  
•    A written agreement exists that specifies the contractual relationship for the time period and the specific service  
 generating the operating statistics included in the NTD Annual report.  
•    The written agreement is signed by authorized representatives of both the buyer and the seller, and should detail the  
 services to be provided, and the nature and amount of the monetary consideration.  

Granting a transportation provider permission to operate certain services through a franchise or license does not, in itself, 
constitute PT. Also, management services contracts, in which all or some personnel or services are provided to manage or 
operate the transit agency, are not PT. Generally, the service is part of the public transit agency’s DO service.  

Cooperative agreements between public transit agencies or governmental units should not be reported as PT services.  
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When to Report  

Exhibit 3 — NTD Monthly Requirements and Timelines  

Form Name Form Purpose Reporting Frequency    Forms Submitted 
Mode Service Operated form (MR-10) Gives NTD the information needed Annually (January) and One per transit 

to generate the ridership activity when a mode or type agency 
forms the transit agency will need of service is added or 
to complete for the reporting year. deleted 

Ridership Activity form (MR-20) Provides NTD with monthly Monthly One per mode / type 
information on service provided by of service (TOS) 
the transit agency. combination 

Monthly Reporting Due Dates 
Month Due Date Month Due Date 
January February 27 July August 31 
February March 31 August September 30 
March April 30 September October 30 
April May 29 October November 30 
May June 30 November December 31 
June July 31 December January 29 of following year 

 
Failure to Report or Late Report  

NTD requires transit agencies to submit complete reports according to the due date schedule. Delinquent reports results  
from not submitting a report, submitting a late report, or not responding to validation inquires. Incomplete reports can no  
longer be submitted. As a result, your transit agency's data may not be included in the NTD. Furthermore, FTA may declare 
your transit agency ineligible to receive any Urbanized Area Formula Program (UAF) grants during an entire Federal fiscal 
year. This ineligibility applies to all transit agencies, regardless of the size of the urbanized area (UZA) served.  

A report is considered late if it is not submitted by the due date. Refer to Exhibit 3 — NTD Monthly Requirements and 
Timelines for due dates.  

The system will auto-generate a series of four e-mails sent per reporting due date:  

1.   A reminder will be sent to the NTD Contact 10 days prior to the due date.  
2.   A second reminder will be sent to the NTD Contact and CEO one day following the due date if no report has been  
 received.  
3.   A late notice will be sent to the NTD Contact and CEO three days following the due date if no report has been received.  
4.   A Delinquency Notice will be sent to the NTD Contact and CEO fifteen days following the due date if no report has been  
 received.  

Please do not respond to these e-mails. These notices are auto-generated by the system the morning it is sent out, and 
should be disregarded if you submitted your report within the last few hours.  

Transit agencies are required to respond to validation inquiries. Failure to respond within the prescribed timeframe may  
result in a delinquent status, which may affect your Urbanized Area Formula Program (UAF) funding eligibility and the  
amount of funding the UZA receives. If your transit agency serves a UZA with a population of 200,000 or more, data will not be 
entered into the formula for selected formula statistics.  

Where to Report  
Transit agencies submit all NTD reports via Internet Reporting at the project's website, www.ntdprogram.gov.  

FTA assigns an NTD analyst to each reporting transit agency to assist reporters throughout the year. Please feel free to 
contact your NTD analyst if there are any questions, or if FTA can do anything to assist you in reporting.  
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Exhibit 4 — NTD Contact Information 

Mailing Address 
You can write to the FTA NTD Project Office at the following 
address: 

Federal Transit Administration 
National Transit Database 
P.O. Box 10967 
Rockville, MD 20849 

Please use the U.S. Postal Service for deliveries to this 
P.O. Box. 

Telephone 
Your NTD analyst and other NTD staff can be contacted by 
telephone on weekdays. For telephone information and 
assistance, call the FTA NTD Project Office at: 

866-349-1427 
The FTA NTD Project Office Help Desk is open from 10:00 am 
to 6:00 pm (Eastern Time). If your NTD analyst is unavailable, 
you may use the voice-mail system and your call will be 
returned, or you may forward your call to another NTD analyst. 

Express Delivery Address 
Express deliveries can be made to the following address: 

Federal Transit Administration 
National Transit Database 
1355 Piccard Drive, Suite 425 
Rockville, MD 20850 

E-mail 
You can contact your NTD analyst by using the e-mail  
address located on the Transit Agency Home tab at: 

www.ntdprogram.gov 
Or contact your NTD analyst for individual e-mail addresses.  

Fax Internet 
The FTA NTD Project Office also maintains a 24-hour FAX Finally, the FTA NTD Project Office manages a website at the 
service. You may FAX correspondence to the FTA NTD Project following address: 
Office at: www.ntdprogram.gov 

301-258-5630 NTD publications and reference documents are available on 
An original of all faxed documents must also be mailed to the the FTA NTD website. 
FTA NTD Project Office.  

 

Data Validation Tools and Validation Checks  

A form script is triggered if there is missing data when the Submit button is clicked. The agency is required to provide all 
missing data in order to submit the NTD Monthly report.  

Beginning with the 2009 calendar year, validation checks have been incorporated into the Monthly module. These validation 
checks are designed to flag:  
•    Monthly variations in the data outside the ranges derived from the historic data reported by the agency (data outliers).  
•    Identical data for successive months.  

You can access these validation checks from the Issues tab. You will be required to either correct the data or explain why 
the data should be acceptable in order to submit your monthly report.  

In addition, a report comparing Monthly data with the most recent submitted Annual data is available from the Reports tab.  

Agencies are encouraged to make changes to the data for any month(s) in the current calendar year, as necessary, to  
ensure that the best available data is reported. Changes can be made without requesting permission from FTA. A change to a 
prior year’s data requires authorization from FTA.  

Reference Information  

This section contains two items necessary to understanding NTD reporting:  

1.   Transit terminology and parameters  
2.   Reference documents.  

Transit Terminology and Parameters  
Reporting data for the NTD requires an understanding of the following transit concepts and terms:  

•    Public transportation  
•    Mode  
•    Type of service (TOS)  
•    Transit agency  
•    Area definitions  
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•    Maximum service vehicles.  

Each of these terms is described in further detail in the sections that follow.  

Public Transportation  

The NTD is established by law as a repository of information on public transportation. The term public transportation is 
synonymous with the terms transit and mass transportation and is defined by law at 49 U.S.C. 5302(a) (10).  

(10) PUBLIC TRANSPORTATION. - The term “public transportation” means transportation by a conveyance that  
provides regular and continuing general or special transportation to the public, but does not include schoolbus, charter, or 
intercity bus transportation or intercity passenger rail transportation provided by the entity described in chapter 243 (or a 
successor to such entity).  

Transit must be open to the public. Transit must also comply with the provisions of the Americans with Disabilities Act of  
1990 (ADA). Services that are only open to specific groups of people are excluded. Examples of excluded services include:  

•    A bus system sponsored by a university that is only open to students, faculty, and staff of the university;  
•    A vanpool sponsored by an employer that only provides service to employees of the employer;  
•    An automated guideway in an airport, which only provides services to customers of the airport.  

Transit includes special transportation, such as complimentary paratransit required by the ADA. Transit also includes other 
shared-ride demand response services, including both sponsored and unsponsored trips.  

Transit excludes schoolbus service. At the time of this writing, FTA has invited public comment on a revised definition of  
schoolbus service in the Federal Register. The NTD will adopt the new definition of schoolbus service, if and when it is  
finalized.  

Transit excludes charter service. In accordance with FTA’s Charter Rule, any service reported to FTA’s charter registration 
website must not be treated as public transportation in NTD reports.  

Transit excludes sightseeing service. Sightseeing service is provided primarily for the enjoyment of sights and sounds during  

the ride, or for enjoyment of the ride itself. Sightseeing service includes services that have narration and services where 
passengers primarily make round-trips without disembarking the vehicle.  

Transit excludes Intercity service. The NTD defines an intercity service as service where a majority of passengers are not  
making a same-day return trip. Thus, for public transportation, a majority of passengers across the totality of the service (i.e. all 
runs on all days of the week) must make a same-day return trip. On public transportation, a majority of passengers use the 
service three or more times a week.  

Transit excludes Amtrak (the entity described in chapter 243.) NTD reporters must demonstrate that they are organizationally 
separate from Amtrak. This exclusion does not apply to cases where Amtrak is the supplier of purchased transportation for 
commuter rail service.  

Mode  

A variety of transit modes are operated in the United States. The NTD reporting system groups transit modes into two broad 
categories — rail modes and non-rail modes — as follows:  
 
Rail Non-Rail 

Alaska railroad (AR) Aerial tramway (TR) 
Automated guideway (AG) Bus (MB) 
Cable car (CC) Demand response (DR) 
Commuter rail (CR) Ferryboat (FB) 
Heavy rail (HR) Jitney (JT) 
Inclined plane (IP) Publico (PB) 
Light rail (LR) Trolleybus (TB) 
Monorail (MO) Vanpool (VP) 

Other (OR)  
 

Type of Service (TOS)  

Public transportation can be provided in two ways:  

1.   Directly operated (DO) service - the NTD reporting agency, usually the public transit agency, uses its own employees to  
 operate the transit vehicles and provide the transit service.  
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2.   Purchased transportation (PT) service - the NTD reporting agency, usually the public transit agency, contracts with a  
 public or private provider to operate the transit vehicles, employ the operators, and provide the transit service.  

TOS is an important element of NTD reporting. On most reporting forms, transit agencies are required to report data by TOS.  

Transit Agency  

A transit agency is responsible for the provision of public transportation service. The transit agency can provide the service 
using its own employees to operate the vehicles (DO service) or contract with a public or private provider to operate the 
transit vehicles and employ the vehicle operators (PT service). With some exceptions, transit agencies typically are public 
bodies and generally are the NTD reporting agencies for their DO and PT services.  

Area Definitions  

The NTD reporting system uses two definitions of area:  

1.   UZA, and  
2.   Service area.  

UZA is defined by the US Census Bureau based on incorporated places (e.g., cities, towns, villages) and their adjacent  
areas that together form a densely populated area of at least 50,000 persons. UZAs do not conform to congressional districts or 
any other political boundaries.  

The most current UZA designations are based on the 2000 census. The NTD reporting system assigns a unique number to 
each of the UZAs in the country. All transit providers reporting to the NTD must serve at least one UZA; many reporters 
service multiple UZAs, as well as rural areas (non-UZAs) of less than 50,000 persons.  

The Census-defined UZAs are an important part of NTD reporting requirements. Reporters must report selected data by UZA 
number on two forms - the S-20 and the FFA-10. Transit agencies serving UZAs of 200,000 or more population must report 
security data on the Reportable Incident Report form (S&S-50). Finally, UZA size determines the sampling  
requirements for passenger miles traveled (PMT) data reported on the S-10.  

Service area is a measure of access to transit service in terms of population served and area coverage (square miles). The 
reporting transit agency determines the service area boundaries and population for most transit services using the definitions 
contained in the ADA.  

For most transit agencies, the size of the UZA is different from the size of the service area. In many instances, the size of the  
service area will be smaller than the UZA served. In other cases, where there is broad public support for transit, the size of  
the service area is greater than the size of the UZA. These differences can cause confusion, since a transit agency's NTD  
reporting requirements are based on the size of the UZA served and the data reported are for the transit agency's service  
area.  

Maximum Service Vehicles  

The maximum service operated during the year is an important determinant of a transit system's size and resulting 
performance. Transit agencies are required to report data on two measures of maximum service:  

1.   Vehicles operated in maximum service (VOMS)  
2.   Vehicles available for annual maximum service.  

VOMS is a count of the revenue vehicles scheduled for the peak day and operating period of the peak service season or  
schedule of the year. The revenue count is the typical number of vehicles operated and does not consider the number of  
vehicles operated on atypical days such as holiday celebrations (e.g., Fourth of July), or one-time special events (e.g., World 
Series celebrations, political conventions).  

Vehicles available in annual maximum service is a count of the revenue vehicles available to meet the maximum service  
requirement (revenue vehicles necessary to meet peak demand) for the fiscal year. This count of revenue vehicles includes:  

•    VOMS  
•    Spare vehicles - revenue vehicles used to accommodate routine maintenance and repair operations, and to replace  
 vehicles in scheduled service that breakdown or are involved in accidents.  

The count of vehicles does not include:  

•    Vehicles out for extended major repair or rehabilitation  
•    Emergency contingency vehicles - inactive revenue vehicles that normally would have been disposed of at the end of  
 their useful life. FTA allows transit agencies to retain these vehicles if they are stored and maintained, and part of an  
 approved FTA Emergency Contingency Plan.  
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Reference Documents  
The FTA Uniform System of Accounts (USOA) and Final Rule (49 CFR Part 630) are essential to understanding the forms and 
instructions presented in this manual. You can obtain these documents, as well as the other reference documents listed in 
Exhibit 5 NTD Reference Documents below, by visiting the NTD Project website at www.ntdprogram.gov or calling the NTD 
Project Office at 866-349-1427.  

 
Exhibit 5 — NTD Reference Documents  

The Reference document listed below are available from for downloading or viewing from the NTD website:  
• Current Reporting Manuals 

• Annual 
• Safety and Security 
• Monthly 
• Rural 

• NTD Final Rule (49 CFR Part 630) 
• Uniform System of Accounts (USOA) 
• Government Auditing Standards 
• Fully Allocated Cost Analysis 
• OMB Circular A-87 (Revised 5/4/95, As Further Amended 8/29/97) (http://www.whitehouse.gov/omb/circulars/a087/a087- 

all.html) 
• National Incident-Based Reporting System, Vol. 1: Data Collection Guidelines, US. Department of Justice, Federal Bureau 

of Investigation, Criminal Justice Information Services Division, Aug 2000, 
• UMTA C 2710.1A - Sampling Procedures for Obtaining Fixed Route Bus Operating Data Required Under the Section 15 

Reporting System 
• UMTA C 2710.2A - Sampling Procedures for Obtaining Demand Response Bus System Operating Data Required Under the 

Section 15 Reporting System 
• UMTA C 2710.4A - Revenue Bases Sampling Procedures for Obtaining Fixed Route Bus Operating Data Required Under 

the Section 15 Reporting System 
• UMTA C 2710.6 - Section 15 Accounting and Reporting Release Number 1 
• UMTA C 2710.7 - Section 15 Accounting and Reporting Release Number 2 
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Internet Reporting  
This section describes the Internet reporting functionality, guides the user through the tabs and provides information on 
navigating the system, saving, submitting and printing your report.  
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Tips for Using Internet Reporting ... .................................................................................................................................................20 
Navigating Between Screens ......................................................................................................................................................20 
Saving a Form ... ..........................................................................................................................................................................20 
Printing .........................................................................................................................................................................................20 
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Overview  

Transit agencies must use the National Transit Database (NTD) Internet Reporting system to provide their data via reports to 
the Federal Transit Administration (FTA). NTD Internet Reporting is the online means for transit agencies to enter, save,  
review and revise data, and submit reports. It provides for timely and accurate reporting as all tasks and requirements for the 
NTD can be fulfilled via this system.  

This section provides Internet Reporting information for the NTD Monthly report.  

What Has Changed from Prior Year  
Beginning with the 2009 calendar year, pre-submission validation checks have been incorporated into the Monthly module.  

A report comparing Monthly data with the most recent submitted Annual report data is available from the Reports tab.  

Internet Reporting System Security  
Many measures have been taken to ensure that all data entered into the Internet reporting system are safe and available 
only to those with proper access. The NTD servers and network are secured behind a firewall. The website is password 
protected. Additionally, multiple server and database protection layers protect the database files.  

Detailed Instructions  
 
Accessing Internet Reporting  
Internet reporting is accessed from the NTD Homepage.  

To access Internet reporting:  

•    Connect to the Internet via your Internet service provider (ISP)  
•    Verify your Internet browser settings  
•    Access the Internet reporting website at www.ntdprogram.gov  
•    Access your transit agency’s NTD report via the Internet Reporting Login link.  
 
Connecting to the Internet  

You should use your ISP to connect to the Internet. Internet reporting requires a web browser that is at least a 6.x version 
(e.g., Internet Explorer 6.0).  

If you don’t have the latest version of the browser, go to Microsoft.com to download the latest version free of charge.  
 
Verifying Your Internet Browser Settings  

You should verify that your browser is set to check for newer versions of stored pages with each visit to the website.  

In Internet Explorer, this is done by accessing Tools / Internet Options / General / Temporary Internet Files Settings / Every 
Visit to Page.  
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The National Transit Database Website  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The NTD Homepage offers the following information and data for reporters and others interested in the NTD:  

•    Internet Reporting Login link.  
•    What is the NTD? An overview of the NTD program, milestones in transit history, how to obtain an NTD ID number, and  
 an overview of the NTD reporting forms.  

Reporting Manuals  
•    Annual Reporting: Access to HTML and PDF versions of the current Annual Reporting Manual, an overview of  
 reporting changes and highlights, reporting manual archives, etc.  
•    Monthly Reporting: Access to HTML and PDF versions of the current Monthly Reporting Manual, an overview of the  
 reporting changes and highlights, reporting manual archives, etc.  
•    Safety and Security Reporting: Access to HTML and PDF versions of the current Safety and Security Reporting  
 Manual, Newsletters, Safety and Security frequently asked questions (FAQ), an overview of reporting changes and  
 highlights, reporting manual archives, etc.  
•    Rural Reporting: Access to HTML and PDF versions of the current Rural Reporting Manual and Excel spreadsheets,  
 an overview of reporting changes and highlights, reporting manual archives, etc.  

Data, Publications and Reference Materials  
•    NTD Glossary: HTML version of the NTD Glossary of transit terms.  
•    NTD Reference Materials: NTD reference materials such as the Uniform System of Accounts, FTA Circulars and  
 Federal Register Notices.  
•    Access NTD Data: HTML and downloadable PDF publications, including the Data Tables (also available as MS Excel  
 self executable files), Profiles, National Transit Summaries and Trends, as well as Annual, Monthly and Historical  
 databases (MS Excel self executable files) and other data products.  

NTD Resources  
•    FTA / NTD Presentations, Announcements and Updates: FTA / NTD presentations, new and useful information,  
 interim updates to reporting requirements, etc.  
•    NTD Feedback: The mailing address, telephone number and fax number for the NTD Project site as well as an  
 opportunity to provide comments or suggestions regarding the NTD Program.  
•    Seminars and Training: NTD Reporting Seminars and In-house Training information and registration.  
•    Transit Agency Listing by Region and External Links: Contact information for transit agencies reporting to the NTD  
 listed by UZA and State. Links to:  

•    Federal Transit Administration (FTA)  
•    FTA Safety and Security Office  
•    U. S. Department of Transportation (USDOT)  
•    National Transit Library  
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•    American Public Transportation Association (APTA)  
•    Bureau of Transportation Statistics (BTS)  
•    Accessibility.  

 
Accessing the NTD Report  

Clicking the Internet Reporting Login link will open the Internet Reporting Login page. You must enter your user name and 
password to gain access to NTD Report Home.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Levels of Access  

Internet Reporting provides four levels of access to the NTD Monthly Report:  

1.   CEO access: Edit forms (data entry), approve Chief Executive Officer (CEO) Certification and submit report  
2.   Contact Person access: Edit forms (data entry) and submit report (administrator)  
3.   Editor access: Edit forms (data entry), cannot submit report  
4.   Viewer access: View only including forms, issues, notes and correspondence.  

User Names and Password  

The system access level is determined by the user name. The first three characters of the user name define the access level 
and the last four digits represent the transit agency’s NTD ID. There are four types of user names corresponding to the four 
access levels available within the NTD Report:  

1.   CEO — CEO####  
2.   Contact person — NTD####  
3.   Editor — EDT####  
4.   Viewer — VWR####  

Each transit agency is e-mailed this set of user names with a password for each. Transit agencies determine access within 
their organizations and distribute user names and passwords accordingly.  

A user can change his / her password at any time. Refer to Sys Admin: Changing Your Password for additional information on 
this topic. Users should be aware that passwords expire every ninety days.  

The CEO and NTD Contact Person use their individual passwords for all report areas. The CEO and NTD  
Contact person access all reporting areas (Annual, Monthly and Safety and Security) from the Home tab.  

 

Reporting Structure  
Monthly Reporting includes the following tabs:  
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•    Home: The starting point when entering the NTD report. It displays the transit agency’s NTD analyst information and  
 any project related announcements.  
•    e-File: The e-File screen provides for processing and tracking and Monthly report.  
•    Safety and Security: Access to the Safety and Security forms.  
•    Annual: Access to the Annual reporting modules and forms.  
•    Help: Online version of the Monthly Reporting Manual.  
•    Sys Admin: Change NTD passwords—CEO, NTD Contact Person, Editor and Viewer. You may only change your  
 password. Should you need assistance, contact your NTD analyst.  
•    Communications: Lists a record of the report submissions the agency has made to NTD, including any comments from  
 the agency and the review status of the report.  
•    Monthly: This screen provides access to the NTD Monthly reporting forms for editing and submitting your report to FTA.  
 Form-by-form instructions and reporting details for the Monthly Module are included in the NTD Monthly Reporting  
 Manual. The NTD contact person is responsible for submitting Monthly data to the NTD.  
•    Issues: Displays all the Issues generated for the transit agency’s Monthly report. Issues highlight potential problems  

with specific data items (specific data which fall out of a typical range of values) and are generated each time the transit 
agency saves a form or submits the NTD Monthly report. To correct an Issue, the transit agency may either change the 
data item on the appropriate form or attach a Comment to the individual Issue and explain. You should use this screen to 
review the Issues for report prior to submitting your current NTD Monthly report. All issues must be addressed prior to 
submitting the following month’s data.  

•    Reports: Print and export reports. All reports have been developed to allow the transit agency to print each form or  
 report without altering print settings to fit a form on the page. The reports listed will vary depending on access level.  
•    Notes: Internet Reporting allows the transit agency to create Form Notes to provide additional information applicable to  
 the overall form. Displays all the Form Notes added to the transit agency’s report.  
 
Home: The Monthly Report Homepage  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After completing the logon process you will be taken to the Report Homepage. Click the Home tab near the top of any 
screen to return to the Home tab from another area.  
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e-File  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The e-File tab is located between the Home tab and the Annual tab. The e-File tab is a centralized area in which to 
compose, organize and track agency correspondence with the NTD program.  
 
Annual  
 
 
 
 
 
 
 
These forms have been completed by the NTD contact person. These forms are not editable.  
 
Safety & Security  
 
 
 
 
 
 
 
 
This screen provides access to the Safety and Security Module forms for editing and submitting your reports to FTA.  

Form-by-form instructions and reporting details for the Safety and Security Module are included in the Safety and Security 
Reporting Manual.  
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Help: Obtaining More Information  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the Help tab to display the Help screen. The Help screen provides access to the 2008 Monthly Reporting Manual for 
additional help in completing the NTD report forms. The Help screen displays the table of contents for the Monthly  
Reporting Manual with links to each section of the manual.  
 
Communications Summary: Viewing a History of Correspondence with NTD  
 
 
 
 
 
 
 
 
The Communications tab gives transit agencies a centralized area in which to view past correspondence with the Federal 
Transit Administration’s (FTA) National Transit Database (NTD) program. In addition, the correspondence view can be  
filtered to show only certain processes or communication types.  
 
Sys Admin: Changing Your Password  
 
 
 
 
 
 
 

The Sys Admin screen provides the ability to change your NTD password.  

All passwords expire every ninety days. You can change your password at anytime on the Sys Admin screen by specifying  
your current and new password. To be valid, a password must be at least eight characters long and contain at least one  
letter and one number. It cannot contain spaces. Passwords are case-sensitive. If you do not update your password within  
the ninety-day term, you will be forced to update your password when you first access the system once the ninety-day period  
has expired. The screen is similar to the one available on the Sys Admin screen and the same password rules apply.  
 
Monthly: Providing Ridership Data to NTD  
 
 
 
 
 
 
Click on the Monthly tab to locate the Monthly forms that your agency is required to complete.  
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At the beginning of each calendar year the Monthly tab only provides access to the Mode Service Operated form (MR-10).  

When you have completed, reviewed and saved the Mode Service Operated form (MR-10) Internet reporting will  
automatically generate the Ridership Activity form(s) (MR-20) for each mode / type of service your agency operates.  
 
Issues  
 
 
 
 
 
 
 

You access the Issues screen by clicking the Issues tab. This screen highlights potential problems with specific data items 
identified through the NTD validation process.  

The NTD validation process ensures that NTD reporting requirements are met and that the reported data fall into reasonable 
ranges and make sense.  

NTD validation is an interactive, iterative process with two alternating phases:  
1.   Pre-submission (working data report stage) validation — automatic review prior to submission of the NTD Monthly report  
2.   Post-submission (the original submission or a revision report stage) validation — review by your assigned NTD analyst  
 after submission of the NTD Monthly report.  

In support of the NTD validation process an NTD analyst is assigned to each transit agency. NTD analysts are available to  
assist transit agency personnel and may be contacted at the NTD Project Office. Direct contact information for each analyst  
is available from the Home tab in the Announcements section (NTD Contact Information) Refer to the exhibit in the  
Introduction section of this manual for general NTD contact information (mailing addresses, hours of operation, etc.).  
 
Pre-Submission Validation  

Internet reporting automatically performs issue checks after a form is saved. The issue checks help you assess the 
completeness and reasonableness of your data prior to submission to FTA.  

Issues are classified by issue type according to severity and action required in order to submit the NTD Monthly report:  
•    C (Critical): The transit agency is not able to submit the NTD Monthly report until all Critical issues are corrected.  
•    I (Important): The transit agency is not able to submit the NTD Monthly report until all Important issues are corrected  
 or explained through a Comment associated to the issue. Comments are added to a particular issue via the Add  
 Comments link located adjacent to each issue on the Issues Summary page.  

You can access the complete listing of issues for the specific form by clicking on the Issues tab while viewing the form.  

Prior to the original submission, issues are deleted as you correct the data and resave the forms. Important issues that  
remain when the NTD Monthly report is submitted will continue to be available for review on the Issues tab. Any corrections  
or explanations subsequent to the original submission will be recorded and are available for review by you and the NTD staff.  

As with Form Notes, the issues are frozen with each submission, and can not be altered until the report is 
returned.  

 
Post-Submission Validation by NTD Analysts  

After the transit agency submits the NTD Monthly report the report is frozen as the Original Submission report stage. At  
this point in the process the data cannot be edited by the transit agency. This is also true of each re-submission (revision).  

The issues undergo a series of reviews by NTD staff during which the issue status may be changed. At each stage, you 
should revise forms as necessary, review issues, respond to the issues, save and re-submit the report. The status of an 
issue is not considered to be final until the Closeout letter has been approved.  
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Reports  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the Reports tab to display the Reports screen. This screen provides access to several reports available to assist  
you in preparing your NTD Monthly report. Most notably, the Ridership Activity Summary Report. We suggest that you run 
this report after saving but prior to submitting your data each month.  

Please refer to the section on Printing for instructions on viewing, printing and exporting a report.  

To open a report you should click the corresponding link on the Reports screen and the report will open Adobe Acrobat  
Viewer. You can print the report by clicking the Print button in the upper left corner of the viewer and click the Okay 
button on the resulting Print window. 

You can also review selected reports associated with prior submissions for the current Report Year (i.e., 2008) and prior 
Report Years i.e., 2007 and earlier). To view current or prior year’s reports, click on the Report drop-down menu located 
above the tab line, and select the year and report stage that you wish to view.  
 
Notes: Providing Additional Information  
 
 
 
 
 
 
 
Click on the Notes tab to open the Notes Summary screen. Internet reporting allows the transit agency to create a Form 
Note for information applicable to the overall form.  

Creating a Form Note  

To create a form note, you should click on the Add Form Note link at the top right of the form you are editing or viewing.  
Internet reporting will take you to the Form Notes screen for the specific form. Internet reporting pre-fills the mode and TOS (if 
applicable) for which the note is created. You must complete the note comment.  

To save a form note click on the Save button at the bottom of the screen. To return to the form being edited without saving 
the note, click on the Cancel button.  

Reviewing Form Notes  

Click on the Form Notes tab to view the Form Notes screen. You can review the form notes associated with a specific form or 
all form notes for the report. While working in a form click on the Form Notes tab to display the Form Notes screen for the 
form. The form name, mode and TOS will be displayed just beneath the tabs.  

You also can review form notes associated with prior submissions for the current Report Year (i.e., 2008) and prior Report 
Years (i.e., 2007 and earlier). To view current or prior year’s form notes, click on the Report drop-down menu located above 
the tab line, and select the year and report stage that you wish to view.  

Editing Notes  

While you are in the Working Data report stage, you can edit a form note after it has been created by clicking on the Edit  
Note link in the far right column on the Form Notes screen. Once the NTD report is submitted the notes are frozen and  
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cannot be edited. Notes can only be edited while in the report status is Working Data which is displayed at the top of screen in 
the Report menu.  

Notes are frozen with each submission. If the report is sent back to the transit agency and notes are reviewed or 
added, the previously submitted notes will not be affected.  

 

Printing Form Notes  

You can print all form notes from the Reports tab by clicking the Notes and Issues Report link.  
 
Issues: Validating Data  

You access the Issues screen by clicking the Issues tab. This screen highlights potential problems with specific data items 
identified through the NTD validation process.  

The NTD validation process ensures that NTD reporting requirements are met and that the reported data fall into reasonable 
ranges and make sense. These validation checks are designed to flag:  

•    Monthly variations in the data outside the ranges derived from the historic data reported by the agency (data outliers).  
•    Identical data for successive months.  

Upon saving your most recent report, Internet reporting will notify you if you have issues that you need to address. You will  
be required to either correct the data or explain why the data should be acceptable in order to submit your monthly report.  

In support of the NTD validation process an NTD analyst is assigned to each transit agency. NTD analysts are available to assist 
transit agency personnel and may be contacted at the NTD Project Office. Direct contact information for each analyst is 
available from the Home tab in the Announcements section (refer to the NTD Contact Information) Refer to the exhibit  
under Where to Report in the Introduction section of this manual for general NTD contact information (mailing addresses,  
hours of operation, etc.).  
 
Reports: Accessing Reports to Help Report Monthly Data  

Click on the Reports tab to display the Reports screen. This screen provides access to several reports available to assist 
you in preparing your NTD Monthly report.  

Please refer to the section on Printing for instructions on viewing, printing and exporting a report.  

To open a report click the corresponding link on the Reports screen and the report will open Adobe Acrobat Viewer. You 
can print the report by clicking the Print button in the upper left corner of the viewer and click the Okay button on the  
resulting Print window.  

Tips for Using Internet Reporting  
 
Navigating Between Screens  
Do not use the browser Back and Forward buttons to navigate between screens. Instead, use the Internet Reporting system 
buttons, tabs and links.  

Saving a Form  
A Save button is provided at the bottom of each Internet reporting form. When entering information into a form it is strongly  
recommended that you save the form frequently. This will prevent the loss of data if your Internet connection is unexpectedly  
lost.  

Also, Internet reporting has an automatic time-out feature which will log you off of the system after a period of inactivity. It is  
strongly recommended that you save your work every 15 minutes. Otherwise, there is a risk that the next action you take on  
the system will result in the closure of the screen displayed in your browser and the loss of any data that you had not saved.  

Printing  
 
Printing a Form Report from a Form Screen  

Click on the Print button at the bottom of the Form screen to display the report in Adobe Acrobat Viewer; then click the 
Print button in the upper left corner of the viewer and click the Okay button on the resulting Print window.  
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To Print a Form Report from a Form Screen  

Click on the Print button at the bottom of the Form screen to display the report in the window. Click the Print button  in  
the upper left corner of the viewer. Then click the Okay button on the resulting Print window.  
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Monthly Reporting Module forms  
This module contains two forms:  
1.   Mode Service Operated form (MR-10)  
2.   Ridership Activity form (MR-20).  

The system will not allow the creation of Monthly forms if the agency has an approved Nine or Fewer Vehicles Waiver.  

Contents of this Section  
Mode Service Operated form (MR-10) ..................................................................................................................... .. 23 
Overview ................................................................................................................................................................... ... 23 

Reporting Requirements and Thresholds ............................................................................................................ ... 23 
What Has Changed from Prior Year ..................................................................................................................... .. 23 
Approach ... ............................................................................................................................................................ .. 23 

Detailed Instructions ................................................................................................................................................. ... 24 
Mode ... ................................................................................................................................................................... .. 24 

Multi-Modal Vehicles ... ....................................................................................................................................... . 26 
Add / Delete Mode / Type of Service ..................................................................................................................... . 26 

Line by Line Instructions ... ....................................................................................................................................... ... 27 
Completing the Mode Service Operated form (MR-10) ... ................................................................................... ... 27 

Saving or Closing the Form .............................................................................................................................. ... 27 
Completing the Form .......................................................................................................................................... . 27 
Adding a Mode / Type of Service ..................................................................................................................... ... 27 
Deleting a Mode / Type of Service ..................................................................................................................... . 27 

Ridership Activity form (MR-20) ................................................................................................................................. . 28 
Overview ................................................................................................................................................................... ... 28 

Reporting Requirements and Thresholds ............................................................................................................ ... 28 
What Has Changed from Prior Year ..................................................................................................................... .. 28 
Approach ... ............................................................................................................................................................ .. 28 

Detailed Instructions ................................................................................................................................................. ... 28 
Unlinked Passenger Trips .................................................................................................................................... ... 29 

Example 2 — Transit Agency Makes 100 Percent Count for Bus (MB) to Calculate the Total Unlinked 
Passenger Trips for the Month ........................................................................................................................... . 29 

Actual Vehicle (Passenger Car) Revenue Hours and Miles ................................................................................ .. 29 
Vehicles Operated in Maximum Service ... ........................................................................................................... .. 30 
Number of Regular Service Days Each Month ... .................................................................................................. . 30 
Form Notes ... .......................................................................................................................................................... . 30 

Line by Line Instructions ... ....................................................................................................................................... ... 31 
Completing the Ridership Activity form (MR-20) ... ............................................................................................... .. 31 

Rail Modes ... ...................................................................................................................................................... .. 31 
Non-Rail Modes ................................................................................................................................................ ... 31 
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Mode Service Operated form (MR-10)  

The Mode Service Operated form (MR-10) is completed once at the beginning of the calendar year and revised only if there is 
a new mode and type of service (TOS) added or discontinued during the reporting period. This form is used to identify the 
modes and types of service (TOS) operated by the transit agency. Internet Reporting uses this information to generate the 
appropriate ridership activity forms for the transit agency.  

This form is required for all transit agencies, except those agencies with a Nine or Fewer Vehicles Waiver.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Overview  

The Mode Service Operated form (MR-10) is used to identify the modes and types of service (TOS) operated by the transit 
agency. Internet Reporting uses this information to generate the appropriate ridership activity forms for the transit agency. This 
form is completed once at the beginning of the calendar year and revised only if there is a mode added or discontinued during 
the reporting period.  

Reporting Requirements and Thresholds  
All agencies must complete the Mode Service Operated form (MR-10) annually. The exception is transit agencies with a 
Nine or Fewer Vehicles Waiver, who need not complete this form. Forms will not be generated for agencies that have an 
approved Nine or Fewer Vehicles Waiver.  
 
What Has Changed from Prior Year  
There are no changes to the Mode Service Operated form (MR-10) for CY 2009.  
 
Approach  
The Mode Service Operated form (MR-10) is used to identify the modes and types of service (TOS) operated by the transit 
agency. The data reported on this form is used by Internet Reporting to generate the appropriate Ridership Activity forms 
(MR-20) for the transit agency for the calendar year.  

Internet Reporting prepares one set of monthly forms for each mode / type of service (TOS) operated by the transit agency.  
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Detailed Instructions  

When the Mode Service Operated form (MR-10) is accessed, use the check-boxes to indicate which modes/types of service  
(TOS) are operated by your agency. Once the form has been saved and submitted, the check boxes are no longer active.  

If you need to add or delete a mode or type of service (TOS) during the report year, use the Add / Delete Mode / Type of 
Service button at the bottom of the screen. Common reasons for a mode / type of service being added or deleted:  
•    A mode / type of service (TOS) was discontinued,  
•    A mode / type of service (TOS) was inadvertently reported / omitted on the Mode Service Operated form (MR-10), or  
•    A new mode / type of service (TOS) began operation during the year.  
 
Mode  
Transit agencies operate one or more modes of transit service. A mode is a system for carrying transit passengers described by 
specific right-of-way (ROW), technology and operational features. The NTD recognizes the following modes of public  
transit service: 

Aerial Tramway (TR) Non-Rail - Fixed 
Guideway 
 
 
 
 
 
 
 
 
 
 
 
 
A system of aerial cables with suspended 
vehicles. 
Cable Car (CC) Rail - Fixed Guideway 
 
 
 
 
 
 
 
 
 
 
 
A railway propelled by moving cables  
located beneath the street. While popular  
at the turn of the last century, the only  
surviving system is operated in San  
Francisco. 

Automated Guideway (AG) Rail - Fixed 
Guideway 

 
 
 
 
 
 
 
 
 
 
 

An electric railway of guided vehicles that 
is operated with a computer and without 
vehicle operators. 

Commuter Rail (CR) Rail - Fixed 
Guideway 

 
 
 
 
 
 
 
 
 
 

Typically operated over old freight  
railroad lines and is diesel or electric  
propelled. Usually, the service operates  
between a central city and adjacent  
suburbs. 

Bus (MB) Non-Rail - Fixed Guideway 
or Non-Fixed Guideway 

The most prevalent mode in the  
country, and is powered by a motor  
and fuel contained within the vehicle. 

Demand Response (DR) Non-Rail - 
Non-Fixed Guideway 

Scheduled in response to calls from  
passengers. Passengers with similar  
origins and destinations are often 
scheduled to ride the same vehicle.  
Many transit systems operate demand  
response (DR) service to meet the 
Federal ADA requirements, and 
expenses and passenger trips are 
reportable for DR.  
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Ferryboat (FB) Non-Rail - Fixed 
Guideway 
 
 
 
 
 
 
 
 
 

A mode that carries passengers over a 
body of water using diesel or steam 
powered vessels. 
 
 
 

Jitney (JT) Non-Rail - Non-Fixed 
Guideway 
 
 
 
 
 
 
 
 
 
 

Operated on fixed routes using passenger 
cars or vans as demand warrants without 
fixed schedules or fixed stops. 
 
Publico (PB) Non-Rail - Non-Fixed 
Guideway 
 
 
 
 
 
 
 
 
 
 

Operated over fixed routes, but not on fixed 
schedules. The service is privately owned 
and operated, but is regulated by local or 
state governments. 

Alaska Railroad (AR) Rail - Fixed 
Guideway 
 
 
 
 
 
 
 
 
 
A special railroad that Congress  
recognized for certain FTA funding that 
operates in Alaska. 

Heavy Rail (HR) Rail - Fixed Guideway 
 
 
 
 
 
 
 
 
 
 

An electric railway with exclusive or  
separate right-of-way (ROW) from other  
vehicles or foot traffic. It has high  
passenger carrying capacity and high  
platform loading. Most of the nation’s  
subway services are classified as heavy  
rail. 
Light Rail (LR) Rail - Fixed Guideway 

 
 
 
 
 
 
 
 
 
 

An electric railway that operates in mixed 
traffic with automobiles or has grade  
crossings with automobiles. Typically,  
light rail (LR) trains are short and consist 
of one to two cars. 
Trolleybus (TB) Non-Rail - Fixed 
Guideway 

 
 
 
 
 
 
 
 
 
 

A bus service operated using an electric  
bus that is powered by a motor drawing  
current from overhead wires using trolley  
poles. 

Inclined Plane (IP) Rail - Fixed 
Guideway 

A railway operating on steep slopes 
and grades with vehicles powered by 
moving cables. 

Monorail (MO) Rail - Fixed Guideway 

An electric railway that is suspended 
from or straddles a guideway formed 
by single beam, rail or tube. 

Vanpool (VP) Non-Rail - Non-Fixed 
Guideway 

A commuting service operating under 
pre-arranged schedules for previously 
formed groups of riders in vans. 

Other - If none of the choices fits your 
agency, select the category: Other. 
Internet Reporting will display a box for 
you to describe the other mode.  
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Multi-Modal Vehicles  
If a vehicle is used for more than one mode, report it under each mode for which it is used and describe the use of the 
vehicle using the Add Form Notes link.  

When all data have been entered into the form and verified for accuracy, click on the Submit Report button to generate the 
required forms.  

Add / Delete Mode / Type of Service  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the agency adds or discontinues a new mode / type of service (TOS) (directly operated (DO) or purchased transportation  
(PT)), click on the Add / Delete Mode / Type of Service button at the bottom of the form. A new screen will appear. Click on  
either the Add or Delete Mode / Type of Service button depending on whether a mode / type of service (TOS) is being  
added or discontinued. Select the mode and type of service from the Drop-Down boxes for the correct line and enter either  
the new service start date or the out of service date. Save the form by clicking on the Save button. A form note must be  
created to explain why the mode/type of service needs to be added or deleted. The Validation analyst will either approve or  
deny the change.  
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Line by Line Instructions  
 
Completing the Mode Service Operated form (MR-10)  
From the Monthly tab, click on the Mode Service Operated form (MR-10) link.  

Form Level Help: Click on the Help tab at the top of the screen for form level help. A form note can be attached to any form.  
Use the Add Form Note link for relevant information to a specific field, to the entire form or to multiple forms. Click on the  
Add Form Note link at the top of the screen and enter your note on the Notes screen. You can review and / or edit a form  
note from the Notes tab. Form notes can be edited or revised until the form is Saved after which new form notes can be  
added.  
 
Saving or Closing the Form  
Click on the Submit button to save and submit the form. Click on the Close button to close the form without saving.  
 
Completing the Form  
Lines 1 - 17, column a: Directly Operated (DO) - Vehicles Operated in Maximum Service (VOMS): Select the Check-Box 
(es) to indicate which modes are directly operated by the transit system. Select Other if none of the above apply and  
describe the Other mode in the Describe Other field that appears on the form.  

Lines 1 - 17, column b: Purchased Transportation (PT) - Vehicles Operated in Maximum Service (VOMS): Select the 
CheckBox (es) to indicate which modes are directly operated by the transit system. Select Other if none of the above apply and 
describe the Other mode in the Describe Other field that appears on the form.  
 
Adding a Mode / Type of Service  
•    From the Monthly tab, click on the Mode Service Operated form (MR-10) link.  
•    Click on the Add / Delete Mode / Type of Service button to enter new service.  
•    In the new window, click on the Add Mode / Type of Service button.  
•    Column a: Mode. Select the mode that your agency has begun operating from the Drop-Down menu.  
•    Column b: Type of Service. Select the type of service (TOS) that your agency has begun operating from the Drop-Down  
 menu.  
•    Column c: New Service Start Date. Enter the date that the new mode / type of service (TOS) began operating.  
 
Deleting a Mode / Type of Service  
•    From the Monthly tab, click on the Mode Service Operated form (MR-10) link.  
•    Click on the Add / Delete Mode / Type of Service button to delete an existing service.  
•    In the new window, click on the Delete Mode / Type of Service button.  
•    Column a: Mode. Select the mode that your agency has stopped operating from the Drop-Down menu.  
•    Column b: Type of Service. Select the type of service (TOS) that your agency has stopped operating from the Drop- 
 Down menu.  
•    Column c: Out of Service Date. Enter the date that the mode / type of service (TOS) was taken out of service.  
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Ridership Activity form (MR-20)  

The Ridership Activity form (MR-20) collects monthly information regarding transit service provided by the agency. These 
data provide FTA with monthly trends in passenger usage and service levels.  

This form is required for all transit agencies, except those agencies with a Nine or Fewer Vehicles Waiver.  
 
 
 
 
 
 
 
 
 
 
Overview  
 
Reporting Requirements and Thresholds  
Monthly ridership activity information is collected by mode and type of service (TOS). These data provide FTA with monthly 
trends in passenger usage and service levels.  

Reporters must enter their data by the end of the month following the month for which data is being reported, i.e., January 
data is submitted by the last day of February.  
 
What Has Changed from Prior Year  
There are no changes to the Ridership Activity form (MR-20) for CY 2009  

Validation issues have been added to assist in verifying data prior to submitting your monthly report.  

Clarification: Agencies are required to report only the number of typical days operated in the month. However, unlinked 
passenger trips (UPT), vehicle revenue miles (VRM), vehicle revenue hours (VRH) and vehicles operated in maximum 
service (VOMS) must be reported for all days in the month, including non-typical days such as weekends.  

Approach  
There are two Ridership Activity forms (MR-20) tailored for:  

1.    Rail  

2.   Non-rail.  

The Ridership Activity form (MR-20) is used to report monthly data by mode and type of service (TOS) for the revenue 
vehicles used to provide transit service. The data include:  
•    Service consumed (unlinked passenger trips (UPT))  
•    Service supplied (actual vehicle (passenger car) revenue miles (VRM) and hours (VRH))  
•    Passenger cars in operation / vehicles operated in maximum service (VOMS)  
•    Number of regular service days operated.  

The data items in this form are similar to the annual data reported on the Service form (S-10). The data reported on the 
Ridership Activity form (MR-20) must be consistent with the annual data reported in the Service form (S-10).  

Detailed Instructions  

Data fields for future months will not appear until the prior month’s data has been submitted. As the form is being completed, 
changes should be saved by clicking the Save button frequently.  

When all data have been entered for a particular month and the data have been verified for accuracy, the month’s data  
should be date stamped by clicking the Edit Date button at the end of the row. The date under the Submit Date column  
should reflect the current date. Next click on the Save button at the bottom of the form to save the data. If you do not click on  
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the Save button at the bottom of the form, the data will not be saved. Any change to a prior month’s data takes effect only  
after the Edit Date button is clicked and a submit date shows in the column for Submission date. The reporter will be notified of 
any missing data prior to the submission of the NTD Monthly report.  

Any zero data will have to be explained by the agency via the e-File tab.  

To close the form, click on the Close button to return to the Monthly tab. The submit date is the date that the user last 
updated and saved data for a particular month. Monthly data can be updated, date stamped and saved until the end of 
February of each year, after this time revisions must be done through your Monthly analyst.  

To revise data for prior months, enter the data in the appropriate cell for the month being revised. Click on the Edit Date  
button at the end of the row. The date under the Submit Date column should reflect the current date. Next, click on the Save 
button at the bottom of the form. To close the form, click on the Close button to return to the Monthly tab.  
 
Unlinked Passenger Trips  
Unlinked passenger trips (UPT) are the number of passengers who board public transportation vehicles. Passengers are  
counted each time they board vehicles no matter how many vehicles they use to travel from their origin to their destination.  

FTA requires 100 percent counts if available and reliable. If not available or reliable, the application of a methodology  
developed for estimating monthly trips is allowed and does not need to be the same as the one used in annual reporting. 
However, the two methodologies cannot be biased in relation to each other.  

Actual counts (100 percent sample) involve counting passengers each time they board a vehicle. This method is generally 
applicable to smaller systems, but its use is not precluded by a system’s size.  

If the transit agency uses a sampling method, the total unlinked passenger trips (UPT) for a specific month should be  
estimated using the sample data collected during the month and the same procedure that the transit agency uses to estimate 
annual unlinked passenger trips (UPT). This approach may not meet FTA’s confidence and precision levels for annual data (+-
10% precision for a 95% confidence level), but does meet FTA’s requirements for a good faith effort for reporting monthly data 
on the Ridership Activity form (MR-20).  

If the transit agency changes its sampling procedure, it should revise its reported unlinked passenger trips (UPT) for the 
current year and the prior year using the new methodology. The transit agency should contact their Validation analyst for 
assistance in reporting the revised estimates for the prior year.  

Other estimation methods not necessarily based on sampling can also be used. For example, monthly fare box revenues  
can be used, provided that bias correction factors are factored into the method to account for trips for which no fare box  
revenues are recorded, or a large number of intra-modal transfers skews the relationship of trips and fare box revenues.  

 
 
Example 2 — Transit Agency Makes 100 Percent Count for Bus (MB) to Calculate the Total Unlinked 
Passenger Trips for the Month  
Day Number of Days in Month Total Unlinked Passenger Trips 
Weekday 21 46,956 
Saturday 5 5,987 
Sunday 5 3,125 
Solution: The total unlinked passenger trips for weekday, Saturday, and Sunday are summed to arrive at the total unlinked 
passenger trips for the month.  
Total 31 56,068 
The transit agency reports 56,068 for total unlinked passenger trips (UPT) for the month.  

 
If the transit agency uses an estimation method to report the data and not 100 percent counts, this method does not need to be 
the same procedure that the transit agency uses to estimate annual unlinked passenger trips (UPT). However, the two 
methods cannot be biased in relation to each other. The annual data and the cumulative monthly data for the agency’s fiscal 
year should be very close, if not identical.  

Actual Vehicle (Passenger Car) Revenue Hours and Miles  
Actual vehicle revenue hours (VRH) and miles (VRM) are incurred when non-rail service is available to the general public. 
These are the miles and hours traveled by vehicles in carrying passengers, plus layover/recovery time. It does not include 
the miles and hours for items such as deadhead, charter services, school bus service, operator training or maintenance 
testing. For rail service, the data are reported in terms of passenger car revenue hours and miles.  
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Vehicles Operated in Maximum Service  
This is the number of revenue vehicles/passenger cars operated to meet the maximum service requirement during the 
month. In most instances, this is the number of scheduled vehicles/passenger cars since most transit agencies have 
sufficient vehicles/passenger cars to operate the scheduled service. Vehicles operated in maximum service (VOMS) / 
passenger cars in operation exclude atypical days or one-time special events.  

This data item is different than the vehicles operated in annual maximum service (VOMS) that is reported on the Service 
form (S-10). The difference between the forms is the time period used in the definition— a month in the Ridership Activity 
form (MR-20) and a fiscal year in the Service form (S-10).  

Number of Regular Service Days Each Month  
Enter the number of days during the month that the agency operates normal weekday service. Saturday, Sunday (holiday), 
reduced or special event service should not be included. This column will only accept a value between 0 and 23.  
 
Form Notes  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A Form Note can be attached to any form to explain unusual circumstances or data discrepancies that impact the data being  
submitted to the NTD. Use the Add Form Note link for relevant information to a form. Click on the Add Form Note link at  
the top of the screen and enter your note on the Notes screen. You can review and / or edit a Form Note from the Notes  
tab.  
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Line by Line Instructions  
 
Completing the Ridership Activity form (MR-20)  
From the Monthly screen, click on the Ridership Activity form (MR-20) link for the applicable mode / type of service (TOS).  

Complete the Ridership Activity form (MR-20) following the instructions in this section. Data fields for future months will not 
appear until the 1st of the following month (i.e., February will not be available until March 1).  

Form Level Help: Click on the Help tab at the top of the screen for form level help. A form note can be attached to any form. 
Use the Add Form Note link for relevant information to a specific field, to the entire form or to multiple forms. Click on the  
Add Form Note link at the top of the screen and enter your note on the Notes screen. You can review and / or edit a form  
note from the Notes tab. Form notes can be edited or revised until the form is Date Stamped and saved after which new  
form notes can be added.  

Saving and Closing the Form: To save your data, click the Save button at the bottom of the form. If you do not click the  
Save button prior to closing the Ridership Activity form MR-20, your data will be lost. You will not be able to save data for 
any month if there are empty data fields for that line. This procedure is followed each month, or each time you return to a prior 
month to revise data.  

Rail Modes  
•    Lines 01-12, column a: By Month - Unlinked Passenger Trips (UPT). Enter the number of unlinked passenger trips  
 (UPT) (need not be audited).  
•    Lines 01-12, column b: By Month - Passenger Car Revenue Hours. Enter the number of actual passenger car revenue  
 hours (data need not be audited).  
•    Lines 01-12, column c: By Month - Passenger Car Revenue Miles. Enter the number of actual passenger car revenue  
 miles (data need not be audited).  
•    Lines 01-12, column d: By Month - Passenger Cars in Operation. Enter the number of passenger cars in operation (data  
 need not be audited).  
•    Lines 01-12, column e: Number of Regular Service Days each Month. Enter the number of days (0-23) during the month  
 that the agency operates normal weekday service. Saturday, Sunday (holiday), reduced or special event service should  
 not be included.  
•    Lines 01-12, column f: By Month - Edit Date. When all data have been entered for a particular month and the data have  
 been verified for accuracy, the month's data should be date stamped by clicking the Edit Date button for that row. The  
 submit date is the date that the user last updated data for a particular month. This procedure is followed each month, or  
 each time you return to a prior month to revise data.  
 
Non-Rail Modes  
•    Lines 01-12, column a: By Month - Unlinked Passenger Trips (UPT.) Enter the number of unlinked passenger trips  
 (UPT) (need not be audited).  
•    Lines 01-12, column b: By Month - Vehicle Revenue Hours (VRH). Enter the number of actual vehicle revenue hours  
 (VRH) (data need not be audited).  
•    Lines 01-12, column c: By Month - Vehicle Revenue Miles (VRM). Enter the number of actual vehicle revenue miles  
 (VRM) (data need not be audited).  
•    Lines 01-12, column d: By Month - Vehicles Operated in Maximum Service (VOMS). Enter the number of vehicles  
 operated in maximum service (VOMS) (data need not be audited).  
•    Lines 01-12, column e: Number of Regular Service Days each Month. Enter the number of days (0-23) during the month  
 that the agency operates normal weekday service. Saturday, Sunday (holiday), reduced or special event service should  
 not be included.  
•    Lines 01-12, column f: By Month - Edit Date. When all data have been entered for a particular month and the data have  
 been verified for accuracy, the month's data should be date stamped by clicking the Edit Date button for that row. The  
 submit date is the date that the user last updated data for a particular month. This procedure is followed each month, or  
 each time you return to a prior month to revise data.  
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